When looking for laptops to purchase for your employees, there are many factors to consider besides excellent performance. System durability and battery life are critical factors for today’s workers, who are always on the go. Their laptops accompany them as they move from office to office, go home for the evening, stop by the coffee shop, and travel using various modes of transportation.

To fit this lifestyle, workers need laptops with high durability and long battery life for the occasions when an electrical outlet is difficult to come by.

We tested how the Dell Latitude E5420 and E6420 laptops, both of which come with Microsoft Windows 7 preinstalled, stood up against competitors from HP and Lenovo. Both Dell laptops withstood three high drops that severely damaged or killed the other systems after only one fall. The Dell Latitude E5420 and E6420 batteries also lasted longer than the competition’s batteries, increasing the time workers could use their systems by as much as 18.2 percent, or an entire hour of working time!
DURABILITY MEETS MOBILITY

Data loss is frustrating and expensive for a company. When workers transport laptops, accidents can occur that cause a laptop to crash to the floor. If a system isn’t durable enough, the hard drive containing that employee’s data will fail, leaving the worker unable to recover any data they haven’t backed up and unable to continue working. To avoid such a loss of productivity and important data from a broken laptop, companies should select laptops that are ready for such accidents.

In our tests, we dropped two Dell Latitude laptops and competitors from HP and Lenovo to the floor from a height of 29 inches. The Dell Latitude E5420 and E6420 withstood damage and protected data, even after three drops. Neither the HP EliteBook 8460p nor the Lenovo ThinkPad T420 emerged intact—each experienced system failure before we were able to finish our testing.

Dell Latitude laptops kept on ticking

As Figure 1 shows, both the Dell Latitude E5420 and Dell Latitude E6420 offered up to 18.2 percent longer battery life than the HP EliteBook 8460p and Lenovo ThinkPad T420.

![Battery life, in minutes](image_url)

In addition to durability and battery life testing, we also compared the four systems in performance. For complete information on how our test systems were configured, see Appendix A.
WHAT WE FOUND

We conducted every test three times. In this section, we present the results for the median run of each test. For complete results, see Appendix B.

Battery life testing

As we mentioned above, the Dell Latitude E6420 and E5420 had the best battery life of the systems we tested: they lasted for 7 hours 34 minutes, and 7 hours 32 minutes, respectively. That’s 20 minutes longer than the Lenovo ThinkPad T420 battery, and over an hour longer than the HP EliteBook 8460p’s battery, which died after only 6 hours 25 minutes.

Figure 2 shows the median results for our battery life testing using the BAPCo® MobileMark® 2007 v1.06 Productivity benchmark.

<table>
<thead>
<tr>
<th>BAPCo MobileMark 2007 v1.06 Productivity</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen brightness</td>
<td>66 nits</td>
<td>67 nits</td>
<td>67 nits</td>
<td>71 nits</td>
</tr>
<tr>
<td>MobileMark 2007 - Productivity - Performance Qualification score</td>
<td>299</td>
<td>306</td>
<td>291</td>
<td>302</td>
</tr>
<tr>
<td>MobileMark 2007 - Productivity - Battery Life score (minutes)</td>
<td>452</td>
<td>454</td>
<td>385</td>
<td>432</td>
</tr>
<tr>
<td>MobileMark 2007 - Productivity - Battery Life score (hours: minutes)</td>
<td>7:32</td>
<td>7:34</td>
<td>6:25</td>
<td>7:12</td>
</tr>
</tbody>
</table>

Figure 2: Median scores for the BAPCo Mobile Mark 2007 v1.06 Productivity benchmark. Higher numbers are better.

Durability testing

We attempted to drop the systems three times each, from a height of 29 inches. After each drop, we used using HD Tune Pro 4.01 and HDDScan 3.2, tests that assess hard drive damage, to measure how well the system had protected its data. Once a system failed to boot, we conducted no further testing on that system.

After the first drop, the HP EliteBook 8460p shut down upon contact with the floor, and we were unable to get the system to boot, leaving us unable to scan the hard drive and complete further testing. Part of the display assembly separated from the display after the drop, which we were able to replace.

The Lenovo ThinkPad T420 fared somewhat better – after the first and second drops, it booted normally, but the system froze when we attempted to run HD Tune Pro when the scan reached a severely damaged portion of the hard drive. Note that the HDDScan bad blocks results in Figure 3 do not represent a complete scan of the entire hard drive because the system froze; therefore the bad blocks for the hard drive would
be much higher. After waiting 24 hours for the scan to complete, the system failed and
could no longer boot into Windows, so we did not drop it a third time. It also
experienced cosmetic damage, as the display assembly separated from the display,
which we were able to partially pop back into place.

The Dell Latitude laptops stood up to our tests, however. After three drops,
each the Dell Latitude E5420 and E6420 were working fine, with no discernable damage
to their hard drives. The cosmetic damage they suffered was that small portions of their
display casings separated from their displays – and we were able to easily pop those
pieces back into place. Additionally, when we dropped the Dell Latitude E5420, the
screen went blank, and the disk tray popped open – neither of these issues caused any
cosmetic or system damage.

Figure 3 shows the results of our hard drive scans.

<table>
<thead>
<tr>
<th>Drop testing – physical data protection</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Drop 1</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HD Tune Pro 4.01 damaged blocks percentage</td>
<td>0%</td>
<td>0%</td>
<td></td>
<td>System froze during scan (no result)</td>
</tr>
<tr>
<td>HDDScan 3.2 bad blocks</td>
<td>0</td>
<td>0</td>
<td></td>
<td>1,215</td>
</tr>
<tr>
<td><strong>Drop 2</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HD Tune Pro 4.01 damaged blocks percentage</td>
<td>0%</td>
<td>0%</td>
<td></td>
<td>System froze during scan (no result)</td>
</tr>
<tr>
<td>HDDScan 3.2 bad blocks</td>
<td>0</td>
<td>0</td>
<td></td>
<td>2,668</td>
</tr>
<tr>
<td><strong>Drop 3</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HD Tune Pro 4.01 damaged blocks percentage</td>
<td>0%</td>
<td>0%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDDScan 3.2 bad blocks</td>
<td>0</td>
<td>3</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Figure 3: The results of our physical data protection drop test for the laptops. Grey blocks indicate the system failed completely and was unable to boot and complete the scans.

**Performance testing**

Because performance is so important to today’s worker, we used two different benchmarks to rate the performance of the laptops, and found that the Dell Latitude E5420 and E6420 are up to completing the tasks workers require.
Figure 4 shows the median results of our BAPCo SYSmark® 2007 Preview v1.06 tests. All four systems showed comparable performance, likely because they feature the same processor. The Dell Latitude E5420 and E6420 achieved SYSmark 2007 Preview v1.06 ratings of 191 and 192, respectively, showing that the systems deliver the performance workers need to complete most business tasks.

<table>
<thead>
<tr>
<th>BAPCo SYSmark 2007 Preview v1.06</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSmark 2007 Preview v1.06 Rating</td>
<td>191</td>
<td>192</td>
<td>193</td>
<td>189</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - E-Learning</td>
<td>175</td>
<td>176</td>
<td>168</td>
<td>174</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - VideoCreation</td>
<td>207</td>
<td>209</td>
<td>196</td>
<td>197</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - Productivity</td>
<td>171</td>
<td>165</td>
<td>189</td>
<td>170</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - 3D</td>
<td>216</td>
<td>222</td>
<td>223</td>
<td>221</td>
</tr>
</tbody>
</table>

Figure 4: Median scores for the BAPCo SYSmark 2007 Preview v1.06 benchmark. Higher numbers are better.

Figure 5 shows the median results of our Futuremark® 3DMark® Vantage 1.1.0 tests. Both the Dell Latitude E5420 and Dell Latitude E6420 successfully completed all 3D tasks. The Dell Latitude E6420, which features both integrated and discrete graphics, performed well with a 3DMark score of 2,397, which was better or comparable to the other laptops, indicating that it can handle even the toughest workloads. The Dell Latitude E5420, which has only integrated graphics, wasn't far behind with a 3DMark score of 1,776.

<table>
<thead>
<tr>
<th>Futuremark 3DMark Vantage 1.1.0</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td>3DMark Score</td>
<td>1,776</td>
<td>2,397</td>
<td>1,916</td>
<td>2,523</td>
</tr>
<tr>
<td>GPU Score</td>
<td>1,398</td>
<td>1,916</td>
<td>1,512</td>
<td>2,027</td>
</tr>
<tr>
<td>CPU Score</td>
<td>9,339</td>
<td>9,693</td>
<td>9,706</td>
<td>9,483</td>
</tr>
</tbody>
</table>

Figure 5: Median scores for the 3DMark Vantage 1.1.0 benchmark. Higher numbers are better.

**WHAT WE TESTED**

In this section, we present a brief overview of what we tested. For step-by-step details on how we tested, see Appendix C.

**Battery life testing**

**BAPCo MobileMark 2007 Productivity 2007**

MobileMark 2007 Productivity 2007 is an industry-standard benchmark that provides a battery life rating and a performance rating based on common office scenarios. In our tests, we focus solely on the battery life rating. MobileMark 2007
Productivity 2007 includes applications and workloads specific to mobile systems. These include office activities like file and document management, data processing, and rich content creation. This module provides a score for battery life of the tested applications.

MobileMark 2007 Productivity 2007 includes the following applications with their corresponding tasks:

- Microsoft Project 2003 (project management)
- Microsoft Excel® 2003 (calculation sheets)
- Microsoft Outlook® 2003 (emails, calendars, scheduler)
- Microsoft PowerPoint® 2003 (slide presentations)
- Microsoft Word® 2003 (formatted text documents)
- WinZip® Computing and WinZip Pro 10.0 (compressed archives)
- Adobe® Photoshop® CS2 (manipulated and compressed images)
- Adobe Illustrator® CS2 (manipulated images)
- Adobe Flash® 8 (vector graphics, animation)

MobileMark 2007 measures system battery life in minutes. MobileMark 2007 records system battery life at the start of the Productivity 2007 benchmark. It repeats the benchmark workload until the system battery life is depleted, or until the system powers down due to low battery life. At the 7 percent battery life setting, MobileMark 2007 records a timestamp once per minute. At the end of the benchmark, it compares the beginning timestamp to the final (last recorded) timestamp. MobileMark 2007 derives its system battery life rating as the number of minutes between the start and end timestamps.


**Durability testing**

To test the drop resistance of each netbook, we performed up to three 29-inch flat drops onto commercial-grade carpet while the netbook was open and running MAXON CINEBENCH R10. After each drop, we measured how well each system had protected its data using HD Tune Pro 4.01 and HDDScan 3.2, tests that assess hard drive damage. After a system failed to boot, we conducted no further testing on that system. If the system continued to boot, we completed three drops.
Performance testing

Futuremark 3DMark Vantage v1.1.0

Futuremark’s 3DMark Vantage v1.1.0 benchmark suite tests system GPU DirectX10 performance, and requires either Microsoft Windows Vista® or Windows 7. 3DMark Vantage v1.1.0 includes testing of GPU-powered physics, DirectX10-specific features, and procedural volumetric effects. Like 3DMark06 v1.2.0, 3DMark Vantage v1.1.0 provides an indication of a system’s 3D gaming capability. For more information on this benchmark, see http://www.futuremark.com/benchmarks/3dmarkvantage/introduction/.

BAPCo SYSmark 2007 Preview v1.06

BAPCo’s SYSmark 2007 Preview v1.06 performance metric tests processor performance in the following four office workload scenarios: e-learning, office productivity, video creation, and 3D modeling. SYSmark 2007 Preview records the time the system takes to complete each individual operation in each scenario. For more information on this benchmark, see http://www.bapco.com/products/sysmark2007preview/.

FINAL THOUGHTS

Choosing laptops for your business is a crucial decision – the systems workers use daily must have top-of-the-line performance, long battery life, and the ability to withstand damage as they are carried from place to place.

In our tests, the Dell Latitude E5420 and Dell Latitude E6420 not only offered solid performance, but also proved more durable than their counterparts from HP and Lenovo, withstanding three drops from a 29-inch height with no damage to their hard drives. In addition, the Dell Latitude laptops we tested lasted up to 18.2 percent longer on a battery charge than their competitors, which means up to an extra hour of time of work or entertainment on the go.
Figure 6 provides detailed configuration information for the test systems.

<table>
<thead>
<tr>
<th>System</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of processor packages</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Number of cores per processor</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>Number of hardware threads per core</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>System power management policy</td>
<td>Dell</td>
<td>Dell</td>
<td>HP Optimized</td>
<td>Energy Saver</td>
</tr>
<tr>
<td>Processor power-saving option</td>
<td>Enhanced Intel® SpeedStep® Technology</td>
<td>Enhanced Intel SpeedStep Technology</td>
<td>Enhanced Intel SpeedStep Technology</td>
<td>Enhanced Intel SpeedStep Technology</td>
</tr>
<tr>
<td>System dimensions (length x width x height)</td>
<td>13-3/4” x 9-5/8” x 1-5/16”</td>
<td>13-7/8” x 9-1/2” x 1-3/16”</td>
<td>13-3/4” x 9-3/8” x 1-3/8”</td>
<td>12-3/8” x 9-1/4” x 1-1/2”</td>
</tr>
<tr>
<td>System weight</td>
<td>5 lbs. 3 oz.</td>
<td>5 lbs. 7 oz.</td>
<td>5 lbs. 7 oz.</td>
<td>4 lbs. 13 oz.</td>
</tr>
<tr>
<td><strong>CPU</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Intel</td>
<td>Intel</td>
<td>Intel</td>
<td>Intel</td>
</tr>
<tr>
<td>Name</td>
<td>Core i5</td>
<td>Core i5</td>
<td>Core i5</td>
<td>Core i5</td>
</tr>
<tr>
<td>Model number</td>
<td>2520M</td>
<td>2520M</td>
<td>2520M</td>
<td>2520M</td>
</tr>
<tr>
<td>Stepping</td>
<td>D2</td>
<td>D2</td>
<td>D2</td>
<td>D2</td>
</tr>
<tr>
<td>Socket type and number of pins</td>
<td>Socket 988B rPGA</td>
<td>Socket 988B rPGA</td>
<td>Socket 988B rPGA</td>
<td>Socket 988B rPGA</td>
</tr>
<tr>
<td>Core frequency (GHz)</td>
<td>2.50</td>
<td>2.50</td>
<td>2.50</td>
<td>2.50</td>
</tr>
<tr>
<td>L1 cache</td>
<td>32 KB + 32 KB (per core)</td>
<td>32 KB + 32 KB (per core)</td>
<td>32 KB + 32 KB (per core)</td>
<td>32 KB + 32 KB (per core)</td>
</tr>
<tr>
<td>L2 cache</td>
<td>512 KB (256 KB per core)</td>
<td>512 KB (256 KB per core)</td>
<td>512 KB (256 KB per core)</td>
<td>512 KB (256 KB per core)</td>
</tr>
<tr>
<td>L3 cache</td>
<td>3 MB</td>
<td>3 MB</td>
<td>3 MB</td>
<td>3 MB</td>
</tr>
<tr>
<td><strong>Platform</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor</td>
<td>Dell</td>
<td>Dell</td>
<td>HP</td>
<td>Lenovo</td>
</tr>
<tr>
<td>Motherboard model number</td>
<td>0H5TG2</td>
<td>032T9K</td>
<td>161C</td>
<td>418064U</td>
</tr>
<tr>
<td>Motherboard chipset</td>
<td>Intel HM65</td>
<td>Intel QM67</td>
<td>Intel QM67</td>
<td>Intel QM67</td>
</tr>
<tr>
<td>BIOS name and version</td>
<td>Dell A01 (04/20/2011)</td>
<td>Dell A05 (05/24/2011)</td>
<td>HP 68SCF Ver. F.01 (03/11/2011)</td>
<td>Lenovo 83ET57WW v1.27 (05/17/2011)</td>
</tr>
</tbody>
</table>
### Memory module(s)

<table>
<thead>
<tr>
<th>System</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vendor and model number</strong></td>
<td>Hynix HMT351S6BF88C-H9</td>
<td>Samsung M471B5273D40-CH9</td>
<td>Hynix HMT351S6BF88C-H9</td>
<td>Samsung M471B5773D40-CH9</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>PC3-10600</td>
<td>PC3-10600</td>
<td>PC3-10600</td>
<td>PC3-10600</td>
</tr>
<tr>
<td><strong>Speed (MHz)</strong></td>
<td>1,333</td>
<td>1,333</td>
<td>1,333</td>
<td>1,333</td>
</tr>
<tr>
<td><strong>Speed running in the system (MHz)</strong></td>
<td>1,333</td>
<td>1,333</td>
<td>1,333</td>
<td>1,333</td>
</tr>
<tr>
<td><strong>Size (MB)</strong></td>
<td>4,096</td>
<td>4,096</td>
<td>4,096</td>
<td>4,096</td>
</tr>
<tr>
<td><strong>Number of memory module(s)</strong></td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td><strong>Chip organization (single-sided/double-sided)</strong></td>
<td>Double-sided</td>
<td>Double-sided</td>
<td>Double-sided</td>
<td>Double-sided</td>
</tr>
<tr>
<td><strong>Channel (single/dual)</strong></td>
<td>Single</td>
<td>Single</td>
<td>Single</td>
<td>Dual</td>
</tr>
</tbody>
</table>

### Hard disk

<table>
<thead>
<tr>
<th>System</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vendor and model number</strong></td>
<td>Seagate ST9320423AS</td>
<td>Seagate ST320LT007-9ZV142</td>
<td>Hitachi HTS725032A9A364</td>
<td>Hitachi HTS723232A7A364</td>
</tr>
<tr>
<td><strong>Number of disks in system</strong></td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td><strong>Size (GB)</strong></td>
<td>320</td>
<td>320</td>
<td>320</td>
<td>320</td>
</tr>
<tr>
<td><strong>Buffer size (MB)</strong></td>
<td>16</td>
<td>16</td>
<td>16</td>
<td>16</td>
</tr>
<tr>
<td><strong>RPM</strong></td>
<td>7,200</td>
<td>7,200</td>
<td>7,200</td>
<td>7,200</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>SATA 3.0 Gb/s</td>
<td>SATA 3.0 Gb/s</td>
<td>SATA 3.0 Gb/s</td>
<td>SATA 3.0 Gb/s</td>
</tr>
<tr>
<td><strong>Controller</strong></td>
<td>Intel Mobile Express Chipset SATA AHCI Controller</td>
<td>Intel Mobile Express Chipset SATA RAID Controller</td>
<td>Intel Mobile Express Chipset SATA AHCI Controller</td>
<td>Intel Mobile Express Chipset SATA AHCI Controller</td>
</tr>
</tbody>
</table>

### Operating system

<table>
<thead>
<tr>
<th>System</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Windows 7 Professional x64</td>
<td>Windows 7 Professional x64</td>
<td>Windows 7 Professional x64</td>
<td>Windows 7 Professional x64</td>
</tr>
<tr>
<td><strong>Build number</strong></td>
<td>7600</td>
<td>7600</td>
<td>7600</td>
<td>7600</td>
</tr>
<tr>
<td><strong>Service Pack</strong></td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td><strong>File system</strong></td>
<td>NTFS</td>
<td>NTFS</td>
<td>NTFS</td>
<td>NTFS</td>
</tr>
<tr>
<td><strong>Kernel</strong></td>
<td>ACPI x64-based PC</td>
<td>ACPI x64-based PC</td>
<td>ACPI x64-based PC</td>
<td>ACPI x64-based PC</td>
</tr>
<tr>
<td><strong>Language</strong></td>
<td>English</td>
<td>English</td>
<td>English</td>
<td>English</td>
</tr>
<tr>
<td><strong>Microsoft DirectX® version</strong></td>
<td>DirectX 11</td>
<td>DirectX 11</td>
<td>DirectX 11</td>
<td>DirectX 11</td>
</tr>
</tbody>
</table>
## System Components

### Graphics # 1

<table>
<thead>
<tr>
<th>System</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vendor and model number</strong></td>
<td>Intel HD Graphics 3000</td>
<td>Intel HD Graphics 3000</td>
<td>AMD Radeon™ HD 6470M</td>
<td>Intel HD Graphics 3000</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Integrated</td>
<td>Integrated</td>
<td>Discrete</td>
<td>Integrated</td>
</tr>
<tr>
<td><strong>Chipset</strong></td>
<td>Intel HD Graphics</td>
<td>Intel HD Graphics</td>
<td>ATI Radeon HD 6470M</td>
<td>Intel HD Graphics</td>
</tr>
<tr>
<td><strong>BIOS version</strong></td>
<td>2089.11</td>
<td>2089.11</td>
<td>BR39846.001</td>
<td>2089.0</td>
</tr>
<tr>
<td><strong>Total available graphics memory (MB)</strong></td>
<td>1,696</td>
<td>1,696</td>
<td>2,791</td>
<td>1,696</td>
</tr>
<tr>
<td><strong>Dedicated video memory (MB)</strong></td>
<td>64</td>
<td>64</td>
<td>1,024</td>
<td>64</td>
</tr>
<tr>
<td><strong>System video memory (MB)</strong></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td><strong>Shared system memory (MB)</strong></td>
<td>1,632</td>
<td>1,632</td>
<td>1,767</td>
<td>1,632</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>1,366 x 768 x 32-bit</td>
<td>1,366 x 768 x 32-bit</td>
<td>1,366 x 768 x 32-bit</td>
<td>1,366 x 768 x 32-bit</td>
</tr>
<tr>
<td><strong>Driver</strong></td>
<td>Intel 8.15.10.2347 (03/28/2011)</td>
<td>Intel 8.15.10.2347 (03/28/2011)</td>
<td>ATI Technologies Inc. 8.821.1.0 (02/06/2011)</td>
<td>Intel 8.15.10.2321 (03/06/2011)</td>
</tr>
</tbody>
</table>

### Graphics # 2

<table>
<thead>
<tr>
<th>System</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vendor and model number</strong></td>
<td>NVIDIA NVS 4200M</td>
<td>N/A</td>
<td>NVIDIA NVS 4200M</td>
<td>NVIDIA NVS 4200M</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>N/A</td>
<td>Discrete</td>
<td>N/A</td>
<td>Discrete</td>
</tr>
<tr>
<td><strong>Chipset</strong></td>
<td>NVIDIA NVS 4200M</td>
<td>N/A</td>
<td>NVIDIA NVS 4200M</td>
<td>NVIDIA NVS 4200M</td>
</tr>
<tr>
<td><strong>BIOS version</strong></td>
<td>75.19.17.01.01</td>
<td>N/A</td>
<td>75.19.15.01.02</td>
<td>75.19.15.01.02</td>
</tr>
<tr>
<td><strong>Total available graphics memory (MB)</strong></td>
<td>N/A</td>
<td>2,244</td>
<td>N/A</td>
<td>2,759</td>
</tr>
<tr>
<td><strong>Dedicated video memory (MB)</strong></td>
<td>N/A</td>
<td>512</td>
<td>N/A</td>
<td>1,024</td>
</tr>
<tr>
<td><strong>System video memory (MB)</strong></td>
<td>N/A</td>
<td>0</td>
<td>N/A</td>
<td>0</td>
</tr>
<tr>
<td><strong>Shared system memory (MB)</strong></td>
<td>N/A</td>
<td>1,732</td>
<td>N/A</td>
<td>1,735</td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>N/A</td>
<td>1,366 x 768 x 32-bit</td>
<td>N/A</td>
<td>1,366 x 768 x 32-bit</td>
</tr>
<tr>
<td><strong>Driver</strong></td>
<td>NVIDIA 8.17.12.6883 (06/05/2011)</td>
<td>N/A</td>
<td>NVIDIA 8.17.12.6802 (04/01/2011)</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Sound card/subsystem

<table>
<thead>
<tr>
<th>System</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Vendor and model number</strong></td>
<td>IDT High Definition Audio</td>
<td>IDT High Definition Audio</td>
<td>AMD High Definition Audio Device</td>
<td>Conexant 20672 SmartAudio HD</td>
</tr>
<tr>
<td>System</td>
<td>Dell Latitude E5420</td>
<td>Dell Latitude E6420</td>
<td>HP EliteBook 8460p</td>
<td>Lenovo ThinkPad T420</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------</td>
<td>---------------------</td>
<td>--------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Ethernet</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Broadcom® NetXtreme® 57xx Gigabit</td>
<td>Intel 82579LM Gigabit</td>
<td>Intel 82579LM Gigabit</td>
<td>Intel 82579LM Gigabit</td>
</tr>
<tr>
<td>Driver</td>
<td>Broadcom 14.4.2.4 (02/07/2011)</td>
<td>Intel 11.8.81.0 (10/28/2010)</td>
<td>Intel 11.8.84.0 (12/21/2010)</td>
<td>Intel 11.8.84.0 (12/21/2010)</td>
</tr>
<tr>
<td>Wireless</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>Intel Centrino® Advanced-N 6205</td>
<td>Intel Centrino Advanced-N 6205</td>
<td>Intel Centrino Advanced-N 6205</td>
<td>Intel Centrino Advanced-N 6205</td>
</tr>
<tr>
<td>Modem</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>N/A</td>
<td>N/A</td>
<td>LSI HDA Modem</td>
<td>N/A</td>
</tr>
<tr>
<td>Driver</td>
<td>N/A</td>
<td>N/A</td>
<td>LSI 2.2.100.0 (01/26/2010)</td>
<td>N/A</td>
</tr>
<tr>
<td>Optical drive(s)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vendor and model number</td>
<td>TSSTcorp TS-L633J</td>
<td>TSSTcorp TS-U633J</td>
<td>HP GT31L</td>
<td>LG GT33N</td>
</tr>
<tr>
<td>Type</td>
<td>DVD-RW</td>
<td>DVD-RW</td>
<td>DVD-RW</td>
<td>DVD-RW</td>
</tr>
<tr>
<td>USB ports</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>4</td>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Type</td>
<td>3 x USB 2.0, 1 x USB 2.0/eSATA</td>
<td>3 x USB 2.0, 1 x USB 2.0/eSATA</td>
<td>2 x USB 3.0, 1 x USB 2.0, 1 x USB 2.0/eSATA</td>
<td>3 x USB 2.0, 1 x USB 2.0/eSATA</td>
</tr>
<tr>
<td>Other</td>
<td>Media card reader</td>
<td>Media card reader</td>
<td>Media card reader</td>
<td>Media card reader</td>
</tr>
<tr>
<td>IEEE 1394 ports</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Monitor</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LCD type</td>
<td>HD LED WXGA</td>
<td>HD LED WXGA</td>
<td>HD LED WXGA</td>
<td>HD LED WXGA</td>
</tr>
<tr>
<td>Screen size</td>
<td>14”</td>
<td>14”</td>
<td>14”</td>
<td>14”</td>
</tr>
<tr>
<td>Refresh rate (Hz)</td>
<td>60</td>
<td>60</td>
<td>60</td>
<td>60</td>
</tr>
<tr>
<td>Battery</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>Dell T54FJ</td>
<td>Dell T54FJ</td>
<td>HP HSTNN-DB2G</td>
<td>Lenovo 42T4791</td>
</tr>
<tr>
<td>Size (length x width x height)</td>
<td>8-1/4” x 2” x 13/16”</td>
<td>8-1/4” x 2” x 13/16”</td>
<td>8” x 1-7/8” x 3/4”</td>
<td>8” x 2-1/8” x 6/8”</td>
</tr>
<tr>
<td>Rated capacity</td>
<td>5300mAh / 11.1V (60Wh)</td>
<td>5300mAh / 11.1V (60Wh)</td>
<td>5600mAh / 11.1V (62Wh)</td>
<td>5200mAh / 10.8V (57Wh)</td>
</tr>
<tr>
<td>Weight</td>
<td>11 oz.</td>
<td>11 oz.</td>
<td>11 oz.</td>
<td>11 oz.</td>
</tr>
</tbody>
</table>

Figure 6: Configuration information for the laptops we tested.
APPENDIX B – DETAILED TEST RESULTS

Battery life testing

Figure 7 shows the complete results for the MobileMark 2007 v1.06 Productivity test runs.

<table>
<thead>
<tr>
<th>BAPCo MobileMark 2007 v1.06 Productivity</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performance Qualification score - Run 1</td>
<td>287</td>
<td>303</td>
<td>291</td>
<td>295</td>
</tr>
<tr>
<td>Performance Qualification score - Run 2</td>
<td>291</td>
<td>306</td>
<td>290</td>
<td>295</td>
</tr>
<tr>
<td>Performance Qualification score - Run 3</td>
<td>299</td>
<td>302</td>
<td>289</td>
<td>302</td>
</tr>
<tr>
<td>Battery Life score (minutes) - Run 1</td>
<td>452</td>
<td>454</td>
<td>385</td>
<td>432</td>
</tr>
<tr>
<td>Battery Life score (minutes) - Run 2</td>
<td>451</td>
<td>454</td>
<td>385</td>
<td>432</td>
</tr>
<tr>
<td>Battery Life score (minutes) - Run 3</td>
<td>452</td>
<td>455</td>
<td>392</td>
<td>432</td>
</tr>
</tbody>
</table>

Figure 7: Complete BAPCo MobileMark 2007 v1.06 Productivity results. Higher numbers are better.

Performance testing

Figure 8 shows the complete results for the SYSmark 2007 Preview v1.06 test runs.

<table>
<thead>
<tr>
<th>BAPCo SYSmark 2007 Preview v1.06</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSmark 2007 Preview v1.06 Rating</td>
<td>191</td>
<td>192</td>
<td>193</td>
<td>189</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - E-Learning</td>
<td>175</td>
<td>176</td>
<td>168</td>
<td>174</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - VideoCreation</td>
<td>207</td>
<td>209</td>
<td>196</td>
<td>197</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - Productivity</td>
<td>171</td>
<td>165</td>
<td>189</td>
<td>170</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - 3D</td>
<td>216</td>
<td>222</td>
<td>223</td>
<td>221</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - E-Learning Run 1</td>
<td>171</td>
<td>171</td>
<td>170</td>
<td>174</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - VideoCreation Run 1</td>
<td>199</td>
<td>210</td>
<td>193</td>
<td>193</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - Productivity Run 1</td>
<td>172</td>
<td>167</td>
<td>188</td>
<td>168</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - 3D Run 1</td>
<td>225</td>
<td>222</td>
<td>216</td>
<td>219</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - E-Learning Run 2</td>
<td>181</td>
<td>174</td>
<td>166</td>
<td>174</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - VideoCreation Run 2</td>
<td>203</td>
<td>207</td>
<td>202</td>
<td>198</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - Productivity Run 2</td>
<td>172</td>
<td>167</td>
<td>187</td>
<td>174</td>
</tr>
</tbody>
</table>
BAPCo SYSmark 2007 Preview v1.06

<table>
<thead>
<tr>
<th>Test Description</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td>SYSmark 2007 Preview v1.06 - 3D Run 2</td>
<td>196</td>
<td>223</td>
<td>226</td>
<td>222</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - E-Learning Run 3</td>
<td>173</td>
<td>183</td>
<td>168</td>
<td>174</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - VideoCreation Run 3</td>
<td>219</td>
<td>209</td>
<td>194</td>
<td>200</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - Productivity Run 3</td>
<td>170</td>
<td>161</td>
<td>191</td>
<td>168</td>
</tr>
<tr>
<td>SYSmark 2007 Preview v1.06 - 3D Run 3</td>
<td>226</td>
<td>221</td>
<td>226</td>
<td>222</td>
</tr>
</tbody>
</table>

Figure 8: Complete SYSmark 2007 Preview v1.06 test results. Higher numbers are better.

Figure 9 shows the complete results for the 3DMark Vantage 1.1.0 test runs.

3DMark Vantage 1.1.0

<table>
<thead>
<tr>
<th>Test Description</th>
<th>Dell Latitude E5420</th>
<th>Dell Latitude E6420</th>
<th>HP EliteBook 8460p</th>
<th>Lenovo ThinkPad T420</th>
</tr>
</thead>
<tbody>
<tr>
<td>3DMark Score - Run 1</td>
<td>1,776</td>
<td>2,403</td>
<td>1,910</td>
<td>2,517</td>
</tr>
<tr>
<td>GPU Score - Run 1</td>
<td>1,398</td>
<td>1,922</td>
<td>1,508</td>
<td>2,019</td>
</tr>
<tr>
<td>CPU Score - Run 1</td>
<td>9,339</td>
<td>9,626</td>
<td>9,631</td>
<td>9,662</td>
</tr>
<tr>
<td>3DMark Score - Run 2</td>
<td>1,778</td>
<td>2,397</td>
<td>1,917</td>
<td>2,523</td>
</tr>
<tr>
<td>GPU Score - Run 2</td>
<td>1,399</td>
<td>1,916</td>
<td>1,512</td>
<td>2,027</td>
</tr>
<tr>
<td>CPU Score - Run 2</td>
<td>9,475</td>
<td>9,693</td>
<td>9,739</td>
<td>9,483</td>
</tr>
<tr>
<td>3DMark Score - Run 3</td>
<td>1,775</td>
<td>2,391</td>
<td>1,916</td>
<td>2,536</td>
</tr>
<tr>
<td>GPU Score - Run 3</td>
<td>1,397</td>
<td>1,911</td>
<td>1,512</td>
<td>2,036</td>
</tr>
<tr>
<td>CPU Score - Run 3</td>
<td>9,367</td>
<td>9,677</td>
<td>9,706</td>
<td>9,656</td>
</tr>
</tbody>
</table>

Figure 9: Complete 3DMark Vantage 1.1.0 test results. Higher numbers are better.
APPENDIX C - HOW WE TESTED

Preparing Windows 7 Professional x64 for testing

1. Verify that each system has Service Pack 1 installed. If it does not, install Service Pack 1.
   a. Download Windows 7 Service Pack 1 x64 (windows6.1-KB976932-X64.exe).
   b. Double-click the executable and follow the default screen steps to install the service pack file.
2. Turn off Windows Automatic Updates:
   a. Click the Windows Start button.
   b. Right-click Computer, and select Properties.
   c. Click Windows Update in the left column.
   d. Click Change settings.
   e. Select Never check for updates, check Receive recommended updates the same way you receive important
      updates, and Allow standard users to install updates on this computer.
   f. Click OK.
3. Turn off the screensaver and power-management options on each system:
   a. Right-click the desktop.
   b. Select Personalize.
   c. Click Screensaver.
   d. Select None from the drop-down menu, and click Apply.
   e. Click Change power settings.
   f. Under the default power scheme, click change plan settings.
   g. Select Never from the drop-down menus next to Dim the display, Turn off the display, and Put the computer
      to sleep.
   h. Click Save changes.
   i. Close any open windows.
4. Note what default power scheme each laptop is set to.
5. Disable Security notifications:
   a. Click the Windows Start button.
   b. Click Control Panel.
   c. Click System and Security.
   d. Click Change Action Center settings.
   e. Uncheck all monitoring alert messages, and click OK.
6. Change User Account Control settings:
   a. Click the Windows Start button.
   b. Click Control Panel.
   c. Click System and Security.
   d. Click Change User Account Control settings.
   e. Move the slider bar to Never notify, and click OK.
   f. In the User Account Control dialog box, click Yes.
7. Leave the brightness at the default level, except for MobileMark testing, which requires the brightness to be set
   to 60 nits or higher (see the section Conducting MobileMark 2007 testing for specific steps).
8. Check the state of the following hardware items and disable each if it is not already disabled:
   • Wireless (use the physical switch if one is available)
   • Bluetooth
   • IR
9. Capture a disk image with Symantec Ghost.
Battery life testing

Antivirus software conflicts

MobileMark 2007 is not compatible with any virus-scanning software, so we uninstalled any such software present on the laptop PCs before we installed the benchmark.

Pre-installed software conflicts

MobileMark 2007 installs the following applications, which its test scripts employ:

- Adobe Flash
- Adobe Photoshop
- InterVideo WinDVD®
- Microsoft Excel
- Microsoft Outlook
- Microsoft PowerPoint
- Microsoft Word
- Microsoft Visual® C++
- Network Associates McAfee® VirusScan®
- WinZip Computing WinZip

If any of these applications are already on the system under test, they could cause problems with the benchmark due to software conflicts. To avoid any such issues, before we installed the benchmark, we uninstalled all conflicting pre-installed software applications, including different versions of any of the programs MobileMark 2007 uses.

Display brightness and power settings

The brightness of a laptop’s display affects its battery life. Therefore, BAPCo requires that, before you test with MobileMark 2007, you do the following step: make sure the brightness of the laptop's monitor is greater than or equal to 60 nits on a completely white screen while the laptop is unplugged and running on battery power. The measurement follows the standards from the Video Electronics Standards Association (www.vesa.org/Standards/summary/2001_6a.htm).

We complied with this standard for all the tests we ran by setting the laptop PC’s brightness as close to 60 nits as we could without going below that brightness level. We used the following procedure before we started each test.

Note: This procedure assumes we began with the laptop plugged into the power supply.

1. To create a completely blank, white screen, open Microsoft Paint by clicking Start → All Programs → Accessories → Paint.
2. Open the Attributes by pressing Ctrl+E.
3. Enter dimensions that are larger than the current screen resolution. For example, if the screen resolution is 1,280 x 800, type 1600 for Width and 1200 for Height.
4. Click OK.
5. Press Ctrl+F to view the bitmap image and render the screen totally white.
6. Wait 45 minutes to allow the screen to warm.
7. Unplug the laptop from the power supply, and measure the display’s brightness using a luminance meter in the center of the screen. (We used the Gossen Mavolux5032C.)
8. If the reading is below or significantly greater than 60 nits, use the laptop’s keyboard screen-brightness-adjustment keys to bring the display as close to 60 nits as possible, then retest.
9. Allow the laptop to run on battery power for 10 minutes, re-measure the display, and adjust the brightness up or down as necessary.
10. Verify that the laptop saved the brightness setting by plugging in the system, unplugging it, and taking another reading.

Note: If the laptop did not save this setting, use its power-management application(s) to set the brightness appropriately, and save that setting. If saving the settings is ineffective, use the keyboard brightness setting keys to adjust the screen to bring the display as close to 60 nits as possible. Next, note how many times you pressed the button to achieve the desired brightness. After unplugging the system under test, use the keyboard to set the desired brightness by pressing the brightness button as many times as you previously noted to return the screen to the correct brightness level.

**BAPCo AutoConfig Tool v2.4.1**

This tool supports three levels of configuration:

1. Only makes changes that are **REQUIRED** in order for the benchmark to run.
2. Additionally, makes changes that are **RECOMMENDED** for repeatable results.
3. Additionally, makes changes that help ensure best results.

We choose Level 3 in the AutoConfig tool.

The BAPCo AutoConfig tool makes the following configuration changes at each of the three levels:

**Level 1—Required**

- Creates and activates a new power scheme that it names MobileMark 2007
- Disables hibernate, standby, and display standby
- Sets hard drive timeout and CPU power management
  - Note: See the following Power schemes section for details on this scheme
- Disables Screen Saver
- Disables Windows Update
- Disables Desktop Cleanup Wizard
- Disables User Account Control (UAC)
- Disables Sidebar

**Level 2—Recommended**

- Completes Level 1
- Disables Windows Security Center warning messages
- Disables Windows Firewall
- Disables incoming Remote Desktop connections
- Disables Windows Error Reporting to Microsoft
- Prevents the Welcome Center from running at startup

**Level 3—Best scores**

- Completes Level 1 and Level 2
- Disables Windows Defender
Power schemes

The BAPCo AutoConfig tool creates a MobileMark 2007 power scheme, which makes the following power option changes:

- Additional settings:
  - Require a password on wakeup: No
- Hard disk:
  - Turn off hard disk after: 3 minutes
- Wireless Adapter Settings:
  - Power Saving Mode: Maximum Power Saving
- Sleep:
  - Sleep after: Never
- USB settings
  - USB selective suspend setting: Enabled
- Power buttons and lid:
  - Lid close action: Do nothing
  - Power button action: Shut down
  - Sleep button action: Sleep
  - Start menu power button: Shut down
- PCI Express:
  - Link State Power Management: Maximum power savings
- Processor power management:
  - Minimum processor state: 5%
  - Maximum processor state: 100%
- Search and Indexing:
  - Power Savings Mode: Power Saver
- Display:
  - Turn off display after: Never
  - Adaptive display: Off (Extends the time that Windows waits to turn off the display)
  - Display brightness: 100% (We then adjust the brightness percentage to be no less than 60 nits)
- Multimedia settings:
  - When sharing media: Prevent idling to sleep
- Battery:
  - Critical battery action: Shut down (on battery), Do nothing (plugged in)
  - Low battery level: 0%
  - Critical battery level: 0%
  - Low battery notification: Off
  - Low battery action: Do nothing

Installing MobileMark 2007 v.1.06 and configuring the system for testing

1. Turn off the wireless network adapter by using the external toggle switch.
2. Insert the MobileMark 2007 Install DVD in the laptop PC’s DVD drive.
3. When the Autoplay appears, click Run setup.exe.
4. At the Welcome screen, click Next.
5. Accept the license agreement, and click Next.
6. At the Choose Destination Location screen, accept the default location of C:\ProgramFiles (x86)\BapCo\MobileMark 2007, and click Next.
7. At the Ready to Install the Program screen, click Install.
8. At the InstallShield Wizard Complete screen, click Finish.
10. Double-click the MobileMark 2007 Patch 5 desktop icon.
11. In the 7-Zip self-extracting archive window, select a location to extract the installation files, and click Extract.
12. Browse to the location of the extracted files, and double-click the MobileMark 2007 folder.
15. At the Welcome screen, click Next.
16. At the Update Complete window, click Finish.
17. Run the BAPCo Auto-configuration tool, v.2.4.1:
   a. Insert the Auto-configuration tool disc in the laptop PC’s DVD drive.
   b. Double-click BAPCo_AutoConfig.bat.
   c. Type M to choose MobileMark 2007.
   d. Type 3 to choose the changes that produce the best possible scores.
   e. Type R to restart the system when the application prompts you to do so.
18. Adjust the screen brightness to no less than 60 nits:
   a. Click the Windows start button, and type power options in the Windows Start Search box.
   b. Click Change plan settings.
   c. Click Change advanced power settings.
   d. Expand the Display option, and change the Display brightness on battery and plugged in to the correct percentage that produces no less than 60 nits.
   Note: If you are unable to save these settings, please see the Displaying Brightness section above.
19. Disable automatic disk defragmentation:
   a. Click the Windows start button, type disk defragmenter in the Windows Start Search box, and press Enter.
   b. Click Configure Schedule.
   c. Uncheck the box next to Run on a schedule, and click OK.
   d. Click Close.
20. Disable System Protection:
   a. Click the Windows start button, type System in the Windows Start Search box. In the search results that appear, click System under the Control Panel heading.
   b. Click System Protection in the left pane.
   c. In the System Properties window under the System Protection tab, click the first Available Drive under the Protection Settings heading, and click Configure.
   d. Click the Turn off system protection radio button, and click OK.
   e. At the Are you sure you want to turn off system protection on this drive? prompt, click Yes.
   f. Repeat steps c through e for any other Available Drives as necessary.
   g. Click OK, and close the System window.
21. Disable Windows Desktop Search indexing:
   a. Click the Windows start button, type Indexing Options in the Windows Start Search box, and press Enter.
   b. Click Modify.
   c. Under Change selected locations, uncheck the boxes next to each indexed location, and click OK.
   d. Click Close.
22. Defragment the hard drive(s):
   a. Click the Windows start button, type disk defragmenter in the Windows Start Search box, and press Enter.
   b. Highlight the local disk drive under Current status, and click Defragment disk.
A Principled Technologies
test report

1. When the process is complete, click Close.

**Conditioning the battery**

1. Plug the AC power adapter into the laptop PC, and completely charge the battery.
2. Install MobileMark 2007 v1.06, following the steps we outlined in the Installing MobileMark 2007 section earlier in this section.
3. Double-click the MobileMark 2007 icon on the desktop.
4. Highlight the Productivity 2007 item in the left panel.
5. Type System Conditioning as the name for this test in the Project Name field in the top-right panel, and click Next Step.
6. If MobileMark 2007 lists no problems or warnings, click Next Step. If it does list any problems or warnings, close MobileMark 2007, and correct the problem(s) before proceeding.
7. After the benchmark integrity check, click Next in the Preparing a new test window.
8. When MobileMark prompts you, unplug the AC power adapter. The Productivity 2007 test begins immediately.
9. The test is complete when the laptop PC has fully depleted its battery and is no longer operational when running on battery power.
10. Plug the AC power adapter into the laptop PC, and completely charge the battery.

**Measuring battery life with MobileMark 2007 v.1.06**

We performed the following steps to run the MobileMark Productivity 2007 benchmark:

1. Double-click the MobileMark 2007 icon on the desktop.
2. Select the Productivity 2007 test by highlighting it in the left panel.
3. Enter a name for this test in the Project Name field in the top right panel, and click Next Step.
4. If MobileMark 2007 lists no problems or warnings, click Next. If it does list any problems or warnings, close MobileMark 2007, and correct the problem(s) before proceeding.
5. After the benchmark integrity check, click Next in the Preparing a new test window.
6. When MobileMark prompts you, unplug the AC power adapter. The test begins immediately.
7. The Productivity 2007 test is complete when the laptop PC has fully depleted its battery and is no longer operational when running on battery power.

We executed the MobileMark Productivity 2007 test three times on the system and took the median battery life run as the representative score for that test.

**Durability testing**

This test measures the damage that the impact from a drop of 29 inches inflicted upon an open laptop running MAXON CINEBENCH R10.

**Setting up CINEBENCH R10**

2. Install CINEBENCH:
   a. Right-click the CINEBENCH ZIP file, and choose Extract All.
   b. In the Select a Destination and Extract Files window, click Browse, click Desktop, and click OK.
   c. Click Extract.

**Running CINEBENCH R10**

1. Launch CINEBENCH R10 by double-clicking the CINEBENCH R10.exe file in the CINEBENCH R10 folder.
2. Enter the MHz frequency of the processor in the MHz (real freq.) field.
3. Click Start all tests.

**Conducting the drop test**

We used a Lansmont PDT56ED Precision Drop Tester, and dropped each laptop onto commercial carpet. We opened the laptop so that the screen and keyboard formed a 120-degree angle, and then placed the laptop flat on the platen. Orienting the laptop in this way resulted in a flat drop. (Figure 10 shows our test setup.)

To allow us to scan the laptops identically, we booted to Hiren’s boot CDs and installed the hard disk scanning software to the Microsoft Windows mini XP virtual machine’s RAMDISK. Running the scanning software from RAM, we scanned the hard disk with HD Tune Pro 4.01 and HDDScan for Windows 3.2, and recorded the number of bad sectors and blocks before and after the drop test. We also recorded any other physical defects, such as cracks or breaks in the display, as well as separated hinges or displaced screws, which the impact of the drop caused. Refer to **Appendix D** for the drop-test checklist. We took still photographs of the laptops before and after each drop. We dropped each laptop three times (unless the system failed to boot after a drop), using this process:

1. Install MAXON CINEBENCH R10 onto the test laptop, as we outline above.
2. Run EFD Software’s HD Tune Pro 4.01 and HDDScan 3.2 to get baseline data on the state of the hard disk. Boot the system using a Hiren’s BootCD disc.
   a. Install HD Tune Pro 4.01:
      i. Insert a USB flash drive containing the HD Tune Pro installation executable, and click once on My Computer.
      ii. Navigate to the USB drive, and double-click the hdtunepro_401_trial.exe installation file to install the application.
      iii. At the welcome screen, click Next.
      iv. Click the I accept the agreement radio button, and click Next.
      v. In the Select Destination Location window, click Browse.
      vi. Click the RAMDisk drive once to select it, and click OK.
      vii. Click Next in the next two windows.
      viii. Leave check box empty for Create a desktop icon, and click Next.
      ix. Click Install.
      x. Leave the check box checked for Launch HD Tune Pro, and click Finish.
   b. Run the HD Tune Pro 4.01 Error Scan:
      i. Select the Error Scan tab.
      ii. Click Start in the right hand pane.
**Note:** The Error Scan is complete when the Start button changes from grey to black.

c. Save the Error Scan Results:
   i. Click the Copy screenshot to clipboard button on the upper right hand menu bar.
   ii. Click the Save screenshot button on the menu bar.
   iii. Save the screenshot by system name and test name.

d. Click the Copy information to clipboard button on the upper right hand menu bar (it is the first button on the left):
   i. Open a new text file by clicking Start→Run, typing `notepad`, and clicking OK.
   ii. In the Notepad window, click Edit→Paste.
   iii. Click File→Save As, enter an appropriate filename using a .txt extension, and choose the location to save the file (we saved ours to a USB flash drive). Click Save.

e. Save the relevant log files:
   i. Click the Health tab.
   ii. Click Log in the bottom right hand corner.
   iii. In the Attribute pane, click (01) Raw Read Error Rate, and click Export.
   iv. Enter an appropriate filename using a .txt extension, choose a location to save the file, and click Open.
   v. Repeat steps 3c and 3d for (05) Reallocated Sector Count and (07) Seek Error Rate.

f. Close the HD Tune Pro 4.01 Hard Disk Utility.

g. Scan the laptop’s hard drive with HDDScan for Windows version 3.2:
   i. Copy the HDDScan folder to the WinPE RAMDisk.
   ii. Open the HDDScan folder, and double-click the HDDScan.exe executable file to run the application.
   iii. Click Tasks→Surface Tests to open the Test Selection window.
   iv. Select Verify from the list of tests, and click Add Test.
   v. At the conclusion of the run, double-click the VR-Verify test id in the Test Manager window to open up the results.
   vi. Select the Report tab, and copy and paste the test results into Notepad.
   vii. Save the results as a text file.

3. Set the height of the platen on the Lansmont Precision Drop Tester to 29 inches above the surface of the 28 oz. commercial carpeting.

4. Place the fully charged laptop on the platen of the drop tester, with the laptop’s base flat on the platen and the screen facing forward, open at a 120-degree angle.

5. Launch CINEBENCH.

6. Unplug the laptop, and drop the laptop onto the commercial carpeting.

7. Wait until the laptop is completely still.

8. If the battery or any other components come off the system, inspect them for damage, and reinstall them if possible.

9. Complete the checklist in Appendix D, including the latest version available of Dell Diagnostics, if applicable.

10. Take digital pictures of the laptop from all angles after completing the checklist.

11. Stop CINEBENCH.

12. Reconnect the laptop’s AC adapter.

13. Run HD Tune Pro 4.01 and HDD Scan 3.2 using the process in Step 2, and record the results as the laptop’s post-test disk status.
Performance testing

We conducted the following performance tests:

- SYSmark 2007 Preview 1.06
- 3DMark Vantage 1.1.0

Testing performance with SYSmark 2007 Preview v1.06

Antivirus software conflicts

SYSmark 2007 is not compatible with any virus-scanning software, so we uninstalled any such software that was present on the laptop PCs before we installed the benchmark.

Pre-installed software conflicts

SYSmark 2007 installs the following applications, which its test scripts employ:

- Adobe Flash
- Adobe Photoshop
- InterVideo WinDVD
- Microsoft Excel
- Microsoft Outlook
- Microsoft PowerPoint
- Microsoft Word
- Network Associates McAfee VirusScan
- WinZip Computing WinZip

If any of these applications are already on the system under test, they will cause problems with the benchmark due to software conflicts. To avoid any such issues, before we installed the benchmark, we uninstalled all conflicting pre-installed software applications, including different versions of any of the programs SYSmark 2007 uses.

Setting up SYSmark 2007 Preview v1.06

1. Disable the User Account Control.
   a. Click Start → Control Panel.
   b. At the User Accounts and Family Safety settings screen, click Add or remove user account.
   c. At the User Account Control screen, click Continue.
   d. Click Go to the main User Accounts page.
   e. At the Make changes to your user account screen, click Turn User Account Control on or off.
   f. At the User Account Control screen, click Continue.
   g. Uncheck Use User Account Control to help protect your computer, and click OK.
   h. At the You must restart your computer to apply these changes screen, click Restart Now.


Running SYSmark 2007 Preview v1.06

1. Reboot the system.
2. Launch SYSmark 2007 Preview by double-clicking the desktop icon.
3. Click Run.
4. Select Official Run, choose three Iterations, and enter a name for that run.
5. After the benchmark finishes, record the results.
Testing processor and graphics performance with 3DMark Vantage 1.1.0

Installing and patching 3DMark Vantage 1.1.0

2. Install 3DMark Vantage 1.1.0 with the default options by double-clicking the 3DMark_Vantage_v110_installer.exe file.
3. At the Welcome screen, click Next.
4. At the License Agreement screen, click I accept the terms of the license agreement, and click Next.
5. At the Setup Type screen, click Express, and click Next.
6. At the Ready to Install the Program screen, click Install.
7. When the 3DMark Vantage Read Me page appears in your Web browser, review the document, and click Close when you are finished.
8. At the Setup Complete screen, click Finish.
9. Launch 3DMark Vantage 1.1.0 by double-clicking on the 3DMark Vantage desktop icon. Enter the registration code, and click Register.
10. Exit 3DMark Vantage 1.1.0.

Running 3DMark Vantage 1.1.0

1. Reboot the system, and wait 2 minutes.
2. Double-click the 3DMark Vantage desktop icon to launch the benchmark.
3. In the 3DMark Vantage Main section, click the Preset pull-down menu arrow, and select Performance.
4. Click the Options tab, then click the Graphic Tests tab, and ensure that both tests are selected.
5. Click the CPU Tests tab, and ensure that both tests are selected.
6. Click the Graphic Tests tab, and ensure that both tests are selected.
7. Click the Feature Tests tab, and deselect all six tests by clicking the check mark by each title.
8. Click Run Benchmark.
9. When the benchmark run completes, take a screenshot of the results, and record them as follows:
   - 3DMark score
   - GPU score
   - CPU score
10. Perform steps 1 through 9 two more times, and report the median of the three runs.
APPENDIX D – DROP TEST CHECKLIST

TEST: ___________________________ UNIT S/N: ___________________________

Dell Diagnostics revision number: ____________
Pre-drop disk scan results: _______________________
Post-drop disk scan results: _______________________

HDD
☐ Verify that HDD is functional

RMS devices
☐ Verify that all internal removable media storage (RMS) devices (FDD, CD-ROM, etc.) are functional

LCD
☐ Abrasion or buffing on the LCD from the keyboard
☐ Loss of pixels at any color layer
☐ Appearance of lines, bars, brightness change, etc.
☐ Broken or deformed parts
☐ Loose or partially unseated connectors

Keyboard
☐ Broken, deformed, or unseated keys
☐ Loss of functionality of any key, Touch Pad, TouchPad buttons, PointStick, or PointStick buttons

External connectors
☐ Broken, deformed, or unseated connectors
☐ Loss of functionality of any connector

Latch
☐ Verify that all latches (display, battery, memory door, etc.) are fully functional

Battery
☐ Verify that the battery is fully functional

Cracks or breakage
☐ Cracks, breakage, deformation, or separation at any point on the display assembly and the base assembly

Paint degradation
☐ Scratches or chipping on painted parts

Floatlines/seams
☐ Separation between LCD back and bezel at any point around display, and between palm rest and base

Hinge caps
☐ Separation or misfit of hinge caps
Doors
☐ Verify that all doors (HDD door, memory door, FDD door, etc.) are fully functional

Screws
☐ Verify that screws are set at their original screw setting

Rubber feet
☐ Movement or dislodging of any rubber (stationary) foot on laptop
ABOUT PRINCIPLED TECHNOLOGIES

We provide industry-leading technology assessment and fact-based marketing services. We bring to every assignment extensive experience with and expertise in all aspects of technology testing and analysis, from researching new technologies, to developing new methodologies, to testing with existing and new tools.

When the assessment is complete, we know how to present the results to a broad range of target audiences. We provide our clients with the materials they need, from market-focused data to use in their own collateral to custom sales aids, such as test reports, performance assessments, and white papers. Every document reflects the results of our trusted independent analysis.

We provide customized services that focus on our clients' individual requirements. Whether the technology involves hardware, software, Web sites, or services, we offer the experience, expertise, and tools to help our clients assess how it will fare against its competition, its performance, its market readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked together in technology assessment for over 20 years. As journalists, they published over a thousand articles on a wide array of technology subjects. They created and led the Ziff-Davis Benchmark Operation, which developed such industry-standard benchmarks as Ziff Davis Media’s Winstone and WebBench. They founded and led eTesting Labs, and after the acquisition of that company by Lionbridge Technologies were the head and CTO of VeriTest.

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

Disclaimer of Warranties; Limitation of Liability:
PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER, PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE. ALL PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED TECHNOLOGIES, INC., ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S TESTING. CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN.